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1. Introduction

1. 1  Overview

IE-CS-MBGW-2TX-1COM is a multi-purpose Serial/Ethernet converter and Modbus TCP/RTU-ASCII protocol gateway and is equipped with 

one configurable RS232/422/485 port and two Ethernet RJ45 ports (acting like an unmanaged 2-Port switch). The ComServer / Modbus 

Gateway is designed for industrial applications and fitted with a robust housing. 

1.2  Device Features

The ComServer / Modbus Gateway supports 6 different operating respective service modes:

▪ Virtual COM Mode Using this mode a PC-based application - normally communicating to a connected serial device by a 

physical COM port - can communicate alternatively with a (remote) serial device using an Ethernet based 

communication via IE-CS-MBGW-2TX-1COM. This modes requires the installation of a virtual COM Port 

driver on the application PC (Setup via Weidmüller ComServer / Modbus Gateway Utility).

▪ TCP Server The device is running as a pure media converter between serial and Ethernet Interface. The device waits 

passively for host computer(s) to establish a TCP/IP connection to exchange data with the connected serial 

device. Any payload of a TCP packet will be converted into a serial data stream and vice versa.

▪ TCP Client As TCP Client the ComServer is running as a pure media converter between serial and Ethernet Interface. 

The device establishes actively a TCP/IP connection to the specified host(s) (TCP Server) to exchange data 

with the connected serial device. Any incoming serial data will be sent as payload of a TCP packet to the 

defined TCP Server(s). 

▪ UDP Server/Client In mode UDP Server/Client the device is running as pure media converter between serial and Ethernet 

Interface. The device can act as UDP Client and UDP Server simultaneously.

▪ Modbus Serial Master In this operation mode the device is running as media and protocol converter (Gateway) between

to TCP Slave Gateway Ethernet-based Modbus TCP and serial Modbus RTU/ASCII devices. This mode allows to integrate Modbus 

TCP Slaves into a serial Modbus application (RS232/RS485) with a Modbus RTU/ASCII Master.

▪ Modbus TCP Master The device is running as media and protocol converter (Gateway) between Ethernet-based Modbus TCP

to Serial Slave Gateway and serial Modbus RTU/ASCII devices. The function is to access serial Modbus RTU/ASCII Slaves by one or 

several Ethernet-based Modbus TCP Master(s).
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2. Hardware Description

1: Terminal block for power input  

PWR1 / PWR2

2: Factory reset button

- Press reset button < 5 seconds to 

reboot the device (Warm Start).

- Press reset button >= 5 seconds to 

reset the Converter/Gateway to 

factory default settings.

3: Power input LEDs (PWR1/PWR2)

4: Link/Activity LEDs Ethernet Ports

(Ethernet 1 / Ethernet 2)

8: 2 x Ethernet RJ45 Ports 

10/100BASE-T(X), behave as 2 

Port unmanaged switch

7: DIP switches for serial line resistor 

settings:

SW1: Sets pull-up resistor to 1 KΩ 

(ON) or 150 KΩ (OFF)

SW2: Sets pull-down resistor to 1 

KΩ (ON) or 150 KΩ (OFF)

SW3: Enables / Disables line 

termination

5: Data Transmission LEDs Serial 

Port (Tx / Rx)

6: Serial Port (DB9 male Connector)

Attention: For device installation and for Safety notice refer to document ‘Hardware 

Installation Guide’ for IE-CS-MBGW-2TX-1COM (Part No. 2682600000).

The document can be downloaded from the Weidmüller Online Product 

Catalogue. Select or search for device name IE-CS-MBGW-2TX-1COM or part 

number 2682600000 and refer to section ‘Downloads’.

Front View

Pinout of Serial Interface DB-9 Connector

Description of LED Indicators Hardware Specifications

1) Note: Above table shows the corrected pinouts for RS-422 and RS-485 

4-wire interface modes. In previous document V1.0 the 

assignments for RX-/RX+ and TX-/TX+ were reversed!
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3. Getting Started

3.1  Hardware Installation

▪ Install and power-up the device according to ‘Hardware Installation Guide’ for IE-CS-MBGW-2TX-1COM (downloadable from the Weidmüller Online 

Product Catalogue). Consider the safety notices mentioned in the HIG.

3.2  Device Access and Configuration

▪ IE-CS-MBGW-2TX-1COM has to be configured primarily via Web interface.

▪ Additionally, some basic configuration settings can be done via the Command Line Interface using a SHH console access. The CLI based 

configuration provides only limited options in comparison to the full-featured web-based configuration.

▪ Software ‘ComServer / Modbus Gateway Utility’ (downloadable from the Weidmüller Online Product Catalogue) can be used for device search 

(across a switched network) and for installation of a virtual COM-Port driver.

3.3  Web Interface Access

▪ Login credentials (Factory default settings):

▪ IP address / Netmask: 192.168.1.110 / 255.255.255.0

▪ Username: admin

▪ Password: Weidmueller

▪ Connect the PC to any Ethernet port of the Converter/Gateway and set the PC’s IP address to a free one of range 192.168.1.0 / 255.255.255.0.

▪ Start a Web browser and enter the IP address of the connected device into the browser’s address line (http://192.168.1.110).

▪ After the appearance of the prompt (login) enter the login credentials. After successful input of username and password the Converter/Gateway will 

be displayed.

3.4  Console Access via SSH

▪ Use for SSH console login (eg. via tool PuTTY) the same credentials as for Web interface access.

▪ Refer to page 37 of this document about short introduction of using the command line interface and the implemented commends.

Note: By factory default settings both the Web interface access via HTTP and HTTPS as well as the SSH console access are allowed.
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4. Web Interface Configuration

▪ Subsequent pages provide a detailed description about the web menu structure and configuration 

pages in terms of functional and parameter settings.

▪ For access to the Web interface any browser can be used. If the device is still set to factory 

defaults use IP address 192.1.68.1.110 and username admin and password Weidmueller for 

login.
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4.1 Menu Basic Settings → System Information

Login page providing a system overview showing these parameters.

Description of parameters

System Name
Shows model name when set to factory default 

settings. Editable via menu ‘Device Description’. 

System Description 
Shows by factory default a functional description of 

the device. Editable via menu ‘Device Description’. 

System Location  
Empty by factory default. Editable via menu ‘Device 

Description’.

System Contact  
Empty by factory default. Editable via menu ‘Device 

Description’. 

Firmware 
Running firmware version. Can be updated via menu 

‘Upgrade Firmware’.

MAC address Device specific MAC address for identification

Serial Number Device specific production number for identification

System Uptime
Provides the elapsed time since device start-up or 

last reboot. Home page after login
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4.2 Menu Basic Settings → Device Description

Configuration of device specific identification and application 

parameters.

Factory default settings

Description of parameter settings

System Name

Enter any name and descriptions for device or 

application identification.

System Description 

System Location  

System Contact  
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4.3 Menu Basic Settings → IP Configuration

Configuration of network settings of Ethernet interface.

Both ports behave like an unmanaged Ethernet switch.

Factory default settings

Description of parameter settings

IP Configuration Selection of IP address assignment (Static or DHCP/BOOTP)

Parameters for static IP address assignment:

IP address Device IP address

Netmask Assignment of network range

Gateway Gateway IP address 

DNS Server 1 IP address of primary DNS server

DNS Server 2 IP address of secondary DNS server
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4.4 Menu Basic Settings → Ethernet Port Setting

Configuration of Ethernet port settings.

Factory default settings

Description of parameter settings

State Enables / Disables the Ethernet port.

Speed/Duplex

Transmission mode of Ethernet port.

Selectable values:

AutoNegotiation, 100 Full, 100 Half, 10 Full or 

10 Half
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4.5 Menu Basic Settings → Time Setting

Configuration of device time settings.

Screenshot of selectable 

time zones

Factory default settings

Description of parameter settings

Set Clock from PC (Button)
Sets the system time same as the connected PC’s 

date/time.

SNTP Client
Enables / Disables date/time synchronization via a remote 

time server.

Time Zone 
Select time zone from drop-down list suitable to the device 

location.

Time Server Enter IP address or Domain name of the time server.

Port Port number of used time protocol (Default = 123).

Sync Status Shows the latest synchronization status with time server.

Notes: When powering-up the system date/time initially is set to date/time 

01.01.2020 00:00:00.

When the device is ready after start-up and if SNTP Client is enabled, the 

system time automatically will be updated if the defined time server can be 

accessed. 
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4.6 Menu Basic Settings → Admin Password

Password change of administrator account (admin).

Note: Only this account is available for device access.

Description of parameter settings:

Old Password
Enter current password if a new password shall be set 

(mandatory).

New Password Enter new password.

Confirm Password Enter new password for confirmation.

Factory default access credentials for login:

User: admin

Password: Weidmueller

Note: After clicking ‘Apply’ button the login windows appears requiring the new 

password.
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4.7 Menu Serial Port Setting → Serial Configuration

Configuration menu for interface and control settings of serial Port1.

Description of parameter settings:

Port Alias
Port Alias can be used to describe or identify the connected 

serial device. Enter any identifying name or device description.

Interface

Select the interface type for the connected serial device. 

Available interfaces: RS232, RS422, RS485 (2-wires) and RS 

485 (4-wires).

Baud Rate
Selection of the serial transmission speed. Selectable values 

range from 110bps to 460800bps.

Data Bits Choose the number of data bits (5, 6, 7 or 8).

Stop Bits
The number of bits used to indicate the end of a byte. 

Selectable values 1 or 2.

Parity Selectable values: None, Even, Mark, Space

Flow Control
Selection of hard-, software-based or deactivated flow control. 

Selectable values: None, XON/XOFF, RTS/CTS, DTR/DSR

Performance

Latency: Guarantees shortest response time.

This option ensures that any received character incoming at 

Serial Port will be sent immediately to the Ethernet network and 

the payload of each incoming IP packet will be forwarded 

immediately to the serial device without any buffering.

Throughput: Guarantees highest data throughput.

This option minimizes the overall Ethernet packet overhead by 

using a larger payload in Ethernet frames consisting of buffered 

received serial data.

Note: This parameter is only valid for Service Mode Virtual 

COM.
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4.8 Menu Serial Port Setting → Data Processing (Overview)

Configuration menu for setting the behavior of data processing.

Via these options the data flow (Latency, Buffering, etc.) between Ethernet 

and serial interface and vice versa can be adapted.

These parameters only are applicable for service modes

- ‘Virtual COM’

- ‘TCP Server’

- ‘TCP Client’ and 

- ‘UDP Server/Client’.

For Modbus service modes 

- ‘Serial Master to TCP Slave Gateway’ and

- ‘TCP Master to Serial Slave Gateway’

these data processing parameters do not have any effect. Modbus related 

parameters can be configured in the configuration menu of the selected 

Modbus service mode.

Parameters for Serial to 

Ethernet  data transmission

(See explanation on the 

next pages).

Parameters for Ethernet to 

serial data transmission

(See explanation on the 

next pages).
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4.8.1 Description of Data Processing:  Behavior of Serial to Ethernet interface data flow

Generally, the overall data flow from receiving data at serial interface (Port 1) and sending out to the Ethernet 

interface depends on parameters

- Delimiter (Byte value) [1]

- S2E Flush Data Buffer After (Timer) [2]

- Force TX Interval Time (Timer) [3]

which control the behavior of Serial-to-Ethernet-Input-Buffer [1, 2] and Transmit-to-Ethernet-Output-Buffer [3].

Behavior of Serial-to-Ethernet-Input-Buffer:

If Delimiter byte(s) are set to 00 then input buffering always is disabled independent of setting of timer 

parameter “S2E Flush Data Buffer After“. In this case each incoming byte from serial port will be forwarded 

immediately to the Transmit Buffer.

Note: If Delimiter(s) shall be applied then always use first Delimiter 1 (being not 00) followed by Delimiter 2, 3 

or 4 if necessary.

If Delimiter byte(s) do have a value other than 00 AND ‘S2E Flush Data Buffer After‘ is set to 0 (ms), then 

incoming bytes will be buffered as long as no Delimiter(s) will be received and match. If the delimiter 

condition match or if the buffer is full (4 kBytes) then data of input buffer will be forwarded to Transmit Buffer.

If Delimiter byte(s) do have a value other than 00 AND “S2E Flush Data Buffer After“ is set > 0 (ms) then 

incoming bytes will be buffered as long as

- delimiter settings do not match or

- elapsed time since first received byte < defined “S2E Flush Data Buffer After“ time.

If one of the conditions triggers, then the buffer content will be forwarded to transmit buffer immediately.

Note: Timer parameter ‚S2E Flush Data Buffer After‘ only can be used in combination with delimiter settings. 

If Delimiter byte(s) are set to 00 (disabled) then ‚S2E Flush Data Buffer After‘ does not have any effect. 

Independent of parameter settings the data always will be forwarded if the buffer is full (4kByte).

Behavior of Transmit Buffer:

If timer parameter ‚Force TX Interval Time‘ is set to 0, then output buffering is disabled. Each incoming byte 

or byte block received from S2E Input Buffer will be sent out immediately as an IP packet via Ethernet 

interface.

If ‚Force TX Interval Time‘ is set 0, then buffering is enabled. In this case the ComServer periodically sends 

out each defined ‘Force TX Interval Time‘ the content of the Transmit buffer as IP packet(s) via Ethernet 

interface.

Diagram of data processing and buffering

Parameters for Serial to 

Ethernet data transmission

Buffers for Serial to 

Ethernet data transmission

Note: Parameter ‘Force TX Interval Time‘ can be used to increase the payload of an 

Ethernet frame by gathering more bytes of the serial input stream. But consider

a possible impact on timing requirements regarding the serial application behind

the Ethernet side . Independent of this parameter the data always will be sent

out if the buffer is full (4kByte).

1

2
3
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4.8.2 Description of Data Processing: Behavior of Ethernet to Serial interface data flow

General the overall data flow from receiving the payload of an Ethernet frame and sending out at serial

interface (Port 1) depends on parameters

- Delimiter (Byte value) [1]

- S2E Flush Data Buffer After (Timer) [2]

which control the behavior of Ethernet-to-Serial-Input-Buffer.

Behavior of Ethernet-to-Serial-Input-Buffer:

If Delimiter byte(s) are set to 00 then input buffering always is disabled independent of setting of timer 

parameter ‘E2S Flush Data Buffer After‘. In this case the payload of each incoming IP packet immediately 

will be send to the serial interface.

Note: If Delimiter(s) shall be applied then always use first Delimiter 1 (being not 00) followed by Delimiter 2, 

3 or 4 if necessary.

If Delimiter byte(s) do have a value other than 00 AND ‘E2S Flush Data Buffer After‘ is set to 0 (ms), then 

the payload of incoming IP packet(s) will be buffered as long as no delimiter byte(s) will be received and 

match. If the delimiter condition match or if the buffer is full (4 kBytes), then buffer data will be sent out at 

serial interface.

If Delimiter byte(s) do have a value other than 00 AND ‘E2S Flush Data Buffer After‘ is set > 0 (ms), then 

the payload of incoming IP packet(s) will be buffered as long as

- the delimiter settings do not match or

- the elapsed time since first received byte/payload has not reached defined ‘E2S Flush Data Buffer   

After‘ time.

If one of the conditions triggers, then the buffer content will be sent out at the serial interface immediately.

Note: Parameter ‚E2S Flush Data Buffer After‘ only can be used in combination with delimiter settings. If 

Delimiter byte(s) are set to 00 (disabled) then ‘E2S Flush Data Buffer After‘ does not have any effect. 

Independent of parameter settings the data always will be sent out if the buffer is full (4kByte).

Diagram of data processing and buffering

Parameters for 

Ethernet to serial 

data transmission

Buffer for Ethernet to 

serial data transmission

1
2
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4.9 Menu Serial Port Setting → Service Mode: Virtual COM

In Virtual COM mode a PC-based application - which normally communicates to a connected 

serial device by a physical COM port - alternatively can communicate with a (remote) serial 

device using an Ethernet based communication via the Serial/Ethernet Converter (ComServer).

To use this function a specific Virtual COM port driver has to be installed and configured on the 

PC, emulating a COM port that can be selected by a software application like a physical COM 

port. For installing a virtual COM port, the software tool “ComServer / Modbus Gateway Utility” 

(Weidmüller-CS-MBGW-Utility.exe) has to be used. When installed and activated the virtual 

COM port driver establishes a TCP/IP connection to the ComServer. Any data sent from the 

PC’s application to the virtual COM port will be forwarded as IP packet payload to the 

ComServer and finally sent out to the serial port. Any data received from the serial port will be 

handled vice versa.

The Virtual COM mode supports up to 5 simultaneous TCP/IP connections, allowing multiple 

hosts (each having installed a virtual COM port driver) to exchange data with the same serial 

device at the same time.

Use of service mode Virtual COM:

• It has to be used together with software “ComServer / Modbus Gateway Utility”.

• For running a virtual COM port application, only software “ComServer / Modbus Gateway Utility” needs 

to be configured. This tool allows to set both, the service mode “Virtual COM” and all mode-related 

parameters on a connected ComServer via the internal communication protocol.

• When creating / mapping a virtual COM Port on the PC the software establishes - based on the 

configured communication parameters - a TCP connection to the ComServer.

• See page 38 for more detailed information about “ComServer / Modbus Gateway Utility”.

Description of parameter settings:

Data Encryption

Disables or enables an SSL/TLS encrypted TCP/IP 

communication between initiating TCP Client and this ComServer

(TCP Server).

Idle Timeout

Disconnects established TCP/IP connection(s) after defined Idle 

time (seconds) if there is no further data transmission on the 

serial interface (due to Inactivity). If Idle Timeout = 0 seconds the 

ComServer never will terminate a consisting TCP/IP connection.

Alive Check

The ComServer sends according to the defined interval time 

(seconds) periodically TCP alive check packages to the remote 

host(s) to evaluate the TCP connection. If the TCP connection is 

no longer alive, the connection will be closed.

Max Connections
Defines the maximum number of simultaneous TCP/IP host 

connections.

Note: The behavior of data processing (Latency, Buffering, etc.) between Ethernet and serial 

interface and vice versa can be adapted via parameters ‘Force TX Interval Time’, 

‘Delimiter’ and ‘Flush Data Buffer After’ in menu Serial Port Setting → Data 

Processing.

Service mode “Virtual 

COM” is selected at 

Factory default settings.
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4.10 Menu Serial Port Setting → Service Mode: TCP Server

In mode TCP Server the Communication Server is running as a pure media converter 

between serial and Ethernet Interface. The device waits passively for host computer(s) 

to establish a TCP/IP connection to exchange data with the connected serial device. 

Any payload of a TCP packet will be converted into a serial data stream and vice versa. 

Up to 5 simultaneous connections are supported, allowing multiple hosts to exchange 

data with the serial device.

Description of parameter settings

Data Encryption

Disables or enables an SSL/TLS encrypted TCP/IP 

communication between initiating TCP Client and this 

ComServer (TCP Server).

Telnet Negotiation
Disables or enables the use of Telnet protocol for establishing a 

connection by a TCP client.

TCP Server Port
Port number on which the ComServer is listening as TCP 

Server.

Idle Timeout

Disconnects existing TCP/IP connection(s) after defined Idle 

time (seconds) if there is no further data transmission on the 

serial interface (due to Inactivity). If Idle Timeout = 0 seconds the 

ComServer never will terminate a consisting TCP/IP connection.

Alive Check

The ComServer sends according to the defined interval time 

(seconds) periodically TCP alive check packages to the remote 

host(s) to evaluate the TCP connection. If the TCP connection is 

no longer alive, the connection will be closed.

Max Connections
Defines the maximum number of simultaneous TCP/IP host 

connections.

Note: The behavior of data processing (Latency, Buffering, etc.) between Ethernet and 

serial interface and vice versa can be adapted via parameters ‘Force TX Interval 

Time’, ‘Delimiter’ and ‘Flush Data Buffer After’ in menu Serial Port Setting → Data 

Processing.

Initial settings after 

selection of this mode
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4.11 Menu Serial Port Setting → Service Mode: TCP Client

In mode TCP Client the ComServer is running as a pure media converter between 

serial and Ethernet Interface. The device establishes actively a TCP/IP connection 

to the specified host(s) (TCP Server) to exchange data with the connected serial 

device. Any incoming serial data will be sent as payload of a TCP packet to the 

defined TCP Server(s). Up to 5 simultaneous connections are supported, allowing 

multiple hosts to exchange data with the serial device.

Description of parameter settings:

TCP Server 1...5
Definition of up to 5 target TCP Servers (IP address and port 

number) for data exchange.

Idle Timeout

Disconnects existing TCP/IP connection(s) after defined Idle time 

(seconds) if there is no further data transmission on the serial 

interface (due to Inactivity). If Idle Timeout = 0 seconds the COM-

Server never will terminate an established TCP/IP connection.

Alive Check

The ComServer sends according to the defined interval time 

(seconds) periodically TCP alive check packages to the remote 

host to evaluate the TCP connection. If the TCP connection is not 

alive, the connection will be closed.

Data Encryption

Disables or enables an SSL/TLS encrypted TCP/IP 

communication between the initiating ComServer (TCP Client) 

and remote host (TCP Server).

Connect on 

Startup: The COM-Server will establish a TCP/IP connection to 

all defined TCP Server(s) automatically after start-up.

Any Character: The COM-Server will establish a TCP/IP 

connection to all defined TCP Server(s) after reception of first 

byte from serial interface.

Note: The behavior of data processing (Latency, Buffering, etc.) between Ethernet and 

serial interface and vice versa can be adapted via parameters ‘Force TX Interval 

Time’, ‘Delimiter’ and ‘Flush Data Buffer After’ in menu Serial Port Setting →

Data Processing.

Initial settings after 

selection of this mode
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4.12 Menu Serial Port Setting → Service Mode: UDP Server / Client

In mode UDP Server/Client the device is running as pure media converter between 

serial and Ethernet Interface. The device can act as UDP Client and UDP Server 

simultaneously.

If UDP Server Mode is enabled the ComServer listens to incoming UDP packets at 

the defined port and forwards the Ethernet payload to the connected serial device.

If UDP Client Mode is activated any incoming serial data will be sent as payload of 

an UDP packet to the defined Server range(s).

Description of parameter settings:

UDP Server related settings

UDP Server Mode Enables or disables the UDP Server Mode.

Listen Port
Definition of UDP port on which the UDP Server listens for 

incoming UDP packets.

UDP Client related settings

UDP Client Mode Enables or disables the UDP Client Mode.

Server Ranges 1...4

Definition of up to 4 UDP Server Ranges as target(s) for sending 

the serial data. Each Server range has to be defined by

- Start IP address,

- End IP address and 

- UDP port number.

Note: The behavior of data processing (Latency, Buffering, etc.) between Ethernet and 

serial interface and vice versa can be adapted via parameters ‘Force TX Interval 

Time’, ‘Delimiter’ and ‘Flush Data Buffer After’ in menu Serial Port Setting →

Data Processing.

Initial settings after 

selection of this mode
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In this operation mode the device is running as Ethernet-to-Serial converter being additionally a protocol converter (Gateway) 

between a Modbus RTU/ASCII Master and Modbus TCP Slaves. This mode allows to integrate Modbus TCP Slaves into a serial 

Modbus application (RS232/RS485) with a Modbus RTU/ASCII Master. From the perspective of the serial Master each defined 

TCP Slave can be accessed via a Device ID like other RTU/ASCII Slaves.

If the serial Modbus Master (RTU or ASCII) starts a request to a Device ID the Modbus Gateway accepts the request if a 

configured TCP Slave matches to this Device ID. The RTU/ASCII request will be converted into the Modbus TCP protocol and 

forwarded to the IP address of the TCP Slave. The response from the TCP Slave will be handled vice versa. A maximum of 16 

TCP Slave connections can be configured in the Modbus TCP slave list.

4.13 Menu Serial Port Setting → Service Mode: Modbus Serial Master to TCP 

Slave Gateway

Note: For Modbus communication diagnostic and failure evaluation enable and use Modbus Traffic 

Monitor (Menu Monitoring / Diagnostics → Modbus Traffic Monitor).

Example of 3 configured 

Modbus TCP slaves

Description of parameter settings:

Serial Protocol Select the used Modbus protocol of the serial Interface (RTU or ASCII).

TCP Slave related Parameters

Device Name Enter any name to describe or identify the TCP Slave device.

IP Address IP address of the Modbus TCP Slave.

TCP Port Port number on which the TCP Slave accepts the Modbus request (Default 502).

Device ID (Real)
Mandatory parameter. This Device ID is related to the real Unit ID configured/set on the TCP 

slave. The Unit ID is part of MBAP Header of Modbus TCP protocol.

Virtual ID (Alias)

Optional parameter. Can be used if several Modbus TCP slaves, having different IP addresses 

but same (unchangeable) Unit IDs, must be addressed via unique IDs by the RTU/ASCII Master.

If configured, the Modbus-GW checks the Virtual ID with ID of a received Master request, 

replaces (if matching) it with the real Device (Unit) ID and forwards the request to the TCP slave. 

When receiving the response from TCP slave containing the real Device (Unit) ID, it will be 

replaced by corresponding Virtual ID and sent back to requesting RTU/ASCII Master.

If not configured, the Modbus-GW only uses parameter Device ID (real) for communication 

between RTU/ASCII Master and TCP Slave.

Inactivity Timeout

Defines the Gateway’s closing behavior of a TCP/IP connection to a TCP Slave. 

-1: The TCP/IP connection will be closed immediately after receiving the response of a 

request or latest after response timeout if the TCP Slave does not respond.

0: The Gateway does never terminate any initiated TCP/IP connection to a TCP Slave.

1 ~ 3600: The Gateway disconnects a consisting TCP/IP connection to a TCP Slave after the 

defined value (seconds) if there is no further data transmission.

Response Timeout

Defines the time (milliseconds) to wait for the response of a TCP slave after forwarding a 

request from the Modbus RTU/ASCII Master. If the defined time is elapsed without any 

response the Modbus-GW assumes that an error has occurred, and the request process will 

be terminated without any further activity. No failure response will be sent to the requesting 

RTU/ASCII Master. Additionally, if after timeout the response from the TCP Slave still will be 

received it will be dropped simply.

Note: For setting of this parameter check the response behavior of the TCP Slave and make 

sure that the overall Master response timeout to this device has a larger value than this 

‘Response Timeout’ (due to an additional low latency for passing the Gateway).

Forward Master 

Broadcast

If checkbox is enabled any incoming RTU/ASCII Master request with ID=0 will be forwarded 

to this TCP Slave.

Note: Broadcast requests (messages) are writing commands and do not expect any 

response. Any broadcast-enabled device should be configured/able to accept a broadcast 

message as writing function.
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In this operation mode the device is running as Ethernet-to-Serial converter and is additionally a protocol converter 

(Gateway) between a Modbus TCP (Master) and Modbus RTU/ASCII (Slaves). Serial Modbus Slaves can be accessed by 

one or several Ethernet-based Modbus TCP Master(s). Based on the received Device (Unit) ID contained in the Modbus 

TCP Master request the Gateway converts and forwards it as RTU/ASCII request to the serial Interface. The response 

from the addressed RTU/ASCII Slave will be handled vice versa.

4.14 Menu Serial Port Setting → Service Mode: Modbus TCP Master to Serial 

Slave Gateway

Description of parameter settings:

Serial Protocol Select the used Modbus protocol of the serial Interface (RTU or ASCII).

ModbusTCP Server Connection Settings

TCP Server Listening Port
Port number on which the Gateway is listening for Modbus TCP Master requests (Normally 

502).

Max. concurrent TCP Master 

Connections

Number of simultaneously allowed TCP connections with requesting Modbus TCP Masters 

(Maximum 10 connections).

Inactivity Timeout

Defines the Gateway’s closing behavior of a TCP/IP connection to a TCP Master.

Dependent on the configured value (seconds) the Gateway actively disconnects an established 

TCP/IP connection to a TCP Master if there was no data transmission during the elapsed 

inactivity time. If set to 0 (Factory default setting) the Gateway never will terminate the TCP 

connection, except it will be terminated if Alive Check is activated and the check has failed.

Alive Check

Note: Parameter added from 

firmware version V3.07.

The device sends according to the defined interval time (seconds) periodically

TCP alive check packages to the remote host to evaluate the TCP connection. If the TCP 

connection is no longer alive, the connection will be closed. Factory default setting is 40 

seconds. If set to 0 the function is disabled.

Modbus RTU/ASCII Slave(s) Settings

Add Offset to Device(s) ID 

The defined Offset will be added (subtracted if minus) on the Device (Unit) ID contained in the 

received TCP Master request. The converted RTU/ASCII request will be forward to the serial 

Interface with included Device ID offset. For responses back to Modbus TCP Master the offset 

will be removed again.

Response Timeout

Defines the time (milliseconds) to wait for the response of the RTU/ASCII slave after 

forwarding the request from the Modbus TCP Master.

If the defined time is elapsed without any response the Gateway assumes that an error has 

been occurred and responses to the requesting Modbus TCP Master with an exception 

message. If a response from the RTU/ASCII slave still will be received after the response 

timeout, then it will be dropped simply.

Note: Parameter Retries after Timeout has been removed from firmware versions equal or higher V3.08. Reason: The failure

management (repeating the request) in case of getting no response from a RTU/ASCII slave has to be managed by the

Modbus TCP Master.

Retries after Timeout

Note: Parameter renamed from 

firmware version V3.07. 

Original naming was ‘Max. 

Retries’.

Defines how often the Modbus Gateway sends the RTU/ASCII request again to the 

serial device after a response timeout has been occurred.

Note: Keep in mind that each retry will enhance the overall timeout until the 

Modbus-GW will send a response to the requesting Modbus Master.

Best practice: Set ‘Retries after Timeout’ = 0, set ‘Response Timeout’ < Modbus 

Master’s response timeout and initiate request retries by Modbus Master (e.g., if a 

slave does not response after first request).

Request Pause

Defines a time delay (milliseconds) between the reception of the Modbus TCP 

Master request and forwarding of the converted RTU/ASCII request to the serial 

RTU/ASCII Slave. If set to zero, then an incoming TCP request will be converted 

and sent out immediately without any delay.

Note: For Modbus communication diagnostic and failure evaluation enable and use Modbus 

Traffic Monitor (Menu Monitoring / Diagnostics → Modbus Traffic Monitor).

Factory default settings
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4.15 Menu System Warnings → Syslog Setting

Default Syslog settings

Configuration menu for Syslog parameter settings

Description of parameter settings:

Local Syslog

Enables / Disables the recording of event messages in the local 

System Event Log (Menu Monitoring/Diagnostics → System 

Event Log).

Remote Syslog 

Server

Enables / Disables the forwarding of system events (UDP data) 

to a remote Syslog Server.

Syslog Server IP IP address of the remote Syslog Server.

Syslog Server Port 
UDP connection Port (typically 514) of the remote Syslog 

Server.
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4.16 Menu System Warnings → SMTP Setting (Simple Mail Transfer Protocol)

Factory default settings

Configuration menu for sending system warnings by e-Mail

This feature can be used to send event messages as e-Mail via Simple Mail Transfer 

Protocol. The event types for which an alarm mail can be generated is defined in menu 

System Warnings → Event Selection.

Description of parameter settings

SMTP Server 
IP address or DNS name of mail server which has to be used as 

mail forwarder.

Port Port number of SMTP Server.

Connection type NONE, SSL or TLS

Server Authentication 
Enables / Disables Server Authentication by Username and 

Password

Username Account name on SMTP Server 

Password Password of account on SMTP Server 

E-mail Sender
This name will be shown as originator when a recipient receives 

the mail.

E-mail Address 1 Mail recipient 1

E-mail Address 2 Mail recipient 2

E-mail Address 3 Mail recipient 3

E-mail Address 4 Mail recipient 4

Note: Due to security aspects nowadays only mails with Server Authentication can be 

sent. For this reason, you need an account on the Mail system which shall be 

used to forward the event mail to the defined mail recipients.
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4.17 Menu System Warnings → SNMP Trap Setting

Factory default settings

Description of parameter settings

Community
This is the community write access string to permit access to the 

SNMP trap server.

Location
Use for information about the device location. This parameter is 

referenced to SNMP parameter ‘sysLocation’.

Contact
Use for information about responsible contact person. This 

parameter is referenced to SNMP parameter ‘sysContact’.

IP Address Trap 

Server 1 .. 4

Enter the IP addresses of maximum 4 target SNMP servers. For 

each configured IP address, a trap will be sent.

Note: Traps will be sent using the default SNMP port number 161.

Configuration menu for sending system warnings by SNMP Traps

This feature can be used to send event messages via Simple Network Management 

Protocol to a SNMP Trap Server. The event types for which a trap message can be 

generated is defined in menu System Warnings → Event Selection.
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4.18 Menu System Warnings → Event Selection

Definition of event notifications are triggerable on states or change of a 

state related to

- General device items

- Handshake signaling of the serial port and

- TCP connection changes.

Note: By factory default only Syslog events are enabled. Triggered 

events can be monitored in menu Monitoring/Diagnostics →

System Event Log.

Default Event settings

Configuration menu for setting system warnings to be signalized by 

SMTP Mail, SNMP Trap or Syslog.
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4.19 Menu Monitoring/Diagnostics → System Event Log

The System Event Log shows all event messages triggered by event 

selection type ‘Syslog’.

Note: The event-related timestamp depends on the time setting of the 

device. The initial time after start-up is set to 2020-01-01 00:00:00. If 

a real timestamp is necessary for the event evaluation either set the 

time manually after power-up or enable the SNTP client to get the real 

time automatically (Menu Basic Settings → Time Setting). Examples of several 

syslog events.
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4.20 Menu Monitoring/Diagnostics → Modbus Traffic Monitor

The Modbus Traffic Monitor can be used for diagnostic purposes and failure evaluation for 

service modes

- Modbus Serial Master to TCP Slave Gateway and

- Modbus TCP Master to Serial Slave Gateway.

If enabled, all Modbus traffic data passing the Gateway will be displayed. Each Modbus 

request/response cycle will be shown by 4 lines representing the 4 steps of the Modbus 

protocol conversion process. 

Process cycle of service mode Modbus Serial Master to TCP Slave Gateway:

1. Input RTU/ASCII Master request at serial port

(generates Data Source = In: Port1)

2. Output TCP request to Slave at Ethernet interface

(generates Data Source = Out: <IP address>:<Port No.>)

3. Input TCP response from Slave at Ethernet interface

(generates Data Source = In: <IP address>:<Port No.>)

4. Output RTU/ASCII response to serial port

(generates Data Source = Out: Port1)

Process cycle of service mode Modbus TCP Master to Serial Slave Gateway:

1. Input TCP Master request at Ethernet interface

(generates Data Source =  In: <IP address>:<Port No.>)

2. Output RTU/ASCII request to Slave at serial port

(generates Data Source = Out: Port1)

3. Input RTU/ASCII response from serial port

(generates Data Source = In: Port1)

4. Output TCP response at Ethernet interface

(generates Data Source = Out: <IP address>:<Port No.>)

If any problem occurs during the process cycle, then it will be signalized as follows:

- Parameter Data Source contains an error message (eg. due to a timeout).

- Parameter Modbus Traffic / Status Data contains any other helpful information.

- Only a part of the messages of the process is shown, giving an indication on 

which interface the problem exist.

Notes: 1) The traffic monitor only can be used for above mentioned Modbus-related service modes!

2) The logged content will be cleared if any device parameter will be changed and applied.

3) The buffer size is 100 lines. When clicking button “Refresh” then the latest 100

entries (max.) will be displayed.

Factory default setting

(Traffic monitoring is disabled.)

Example of a recorded 

Modbus request/response  

cycle for service mode 

“Modbus Serial Master to 

TCP Slave Gateway”.
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4.21 Menu Monitoring/Diagnostics → Alive Message

The “Alive Message” feature is a simple function that pushes a Still-Alive 

notification at defined intervals to a target system.

If enabled, this service periodically sends an UDP message containing 

- Device IP address

- System Name 

- Model Name 

to the recipient IP address according to the defined Keep-Alive Message 

Interval.
Factory default setting
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4.22 Menu Monitoring/Diagnostics → Ping

The “Ping” feature is a simple function to check the network connectivity 

to other network devices via ICMP protocol.

Example of Ping check to IP 

address 192.168.50.97
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4.23 Menu Management → Access Security

Configuration of access security settings.

These settings control the access method for device configuration and the 

general access permit based on the IP address of a connecting device.

Factory default setting

Description of parameter settings

HTTP Access
Enables / Disables the HTTP-based Webinterface access via Port 

80.

HTTPS Access
Enables / Disables the HTTPS-based Web interface access via 

Port 443.

SSH Access 

(Console)

Enables / Disables the access to the Command Line Interface via 

SSH (Port 22).

IP Access Control

Enables / Disables the device access generally based on the IP 

Access Control List.

If enabled and applied, then only members of listed and active IP 

addresses / ranges will have device access.

Attention: If ‘IP Access Control’ will be enabled then the IP address of the connected 

PC should be member of the ‘IP Access Control List’. Otherwise, the Web 

interface connection immediately will be lost after clicking ‘Apply’ button.
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4.24 Menu Management → Backup & Restore

Via this menu the device configuration either can be saved to a configuration file or 

restored from a configuration file.
Factory default 

appearance

Message windows of restore process

Left window appears after clicking ‘Restore’.

Below message appears after clicking 

‘Restart’.

Description of parameter settings:

Backup Settings

Backup File Name 

By factory default the file name is IE-CS-MBGW-2TX-1COM.cfg (Model name).

Enter an appropriate filename for easy identification of the backup file to the 

device.

Button ‘Backup’ Saves the current configuration to the browsers download section.

Restore Settings

Restore File Name Select a saved configuration file from the PC’s directory.

Button ‘Restore’ Starts the restoring process to activate the settings of selected configuration file.

Note about restore 

process

Some seconds after click of button “Restore” a message appears that the 

configuration has been loaded and the device needs to be restarted. Click button 

‘Restart’ and wait around 60 seconds until the device will be ready again.

If the device IP address of the restored configuration is different from the 

current one, then open a new browser window using the new IP address.
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4.25 Menu Management → Upgrade Firmware

Menu used for firmware upgrade.

If available, new firmware file can be downloaded from the Weidmüller Online Product 

Catalogue. Select or search for device name IE-CS-MBGW-2TX-1COM or part number 

2682600000 and refer to section ‘Downloads’ regarding updated firmware files.

Factory default 

appearance

Message windows of firmware upgrade process

Left message appears after clicking ‘Upgrade’.

Below message appears some seconds later.

Description of parameter settings:

File Name Firmware Select your firmware file from your PC’s directory via button ‘Select File’. 

Button ‘Upgrade’

Starts the upgrade process.

Note about firmware upgrade process:

Some seconds after clicking button “Upgrade” a message appears that the 

device will be upgraded by the loaded firmware. Please wait again some 

seconds until the next message appears that the device is rebooting and will 

need around 60 seconds until it will be ready again. 

Note: A firmware upgrade will not change the configuration. After reboot the device will be accessible 

again via same IP address.
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4.26 Menu Management → Factory Default

Menu for reset the device configuration to factory default settings.

Process behavior:

Some seconds after clicking button “Reset Now” a message appears that the 

device will restart. Please wait again some seconds until the device rebooting is 

signalized. Then it takes around 60 seconds until the device will be ready again. 

Note: The factory IP address always is set to 192.168.1.110. If previous IP 

address is different to factory IP address, then open a new browser 

window using factory IP address and default login credentials.

Message windows of Factory default process

Left message appears after clicking ‘Reset Now’.

Below message appears after clicking ‘Reboot’.
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4.27 Menu System Reboot

Menu for initiating a device reboot (warm start).

Process behavior:

After clicking button “Reboot” a message appears that the device is rebooting. The 

process will need around 60 seconds until the device will be ready again. 

Note: After the reboot process the Login window appears again requiring input of 

username and password for Web interface access.

Message after clicking ‘Reboot’.
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5. Command Line Interface (SSH Console)

Additional to the Web interface configuration the ComServer / 

Modbus Gateway can be configured by an implemented Command 

Line Interface via SSH console access.

Use for SSH console login the same credentials as for Web 

interface access.

IP address/Netmask: 192.168.1.110 / 255.255.255.0

Username: admin

Password: Weidmueller

(Factory default settings)

The Command Line Interface provides for configuration a user 

guidance of possible commands and parameter settings.

Note: The Command Line Interface provides only limited 

configuration options in comparison to the full-featured 

web-based configuration.

Sub-level display after 

selection of No. 1 (Overview).

Sub-level display after selection 

of No. 2 (General Settings).

Sub-level display after selection of 

No. 3 (Network Settings).

Sub-level display after selection of No. 2 (IP 

address) of Sub menu Network Settings.

Sample screenshots of Command Line Interface use

Initial display after login 

(Top level)
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6. ComServer / Modbus Gateway Utility

6. 1  Overview

▪ The Weidmüller software ‘ComServer / Modbus Gateway Utility’ is designed  to provide 

a virtual COM port on a Windows PC allowing a communication with remote serial 

devices connected to ComServer IE-CS-MBGW-2TX-1COM (Service mode Virtual 

COM).

▪ When installed and activated the virtual COM port driver establishes a TCP/IP 

connection to the ComServer. Any data sent from the PC’s application to the virtual 

COM port will be forwarded as IP packet payload to the ComServer and finally sent out 

to the serial port. Any data received from the serial port will be handled vice versa.

▪ Several virtual COM ports can be installed and activated concurrently, each mapped to 

the serial port of an individual ComServer..

▪ Additionally, the software utility can be used to detect IE-CS-MBGW-2TX-1COM device 

inside of the local switched network (Broadcast domain) f the PC. 

How to get: The utility can be downloaded from the Weidmüller Online Product Catalogue. 

Select or search for device name IE-CS-MBGW-2TX-1COM or part number 

2682600000 and refer to section ‘Downloads’.

Note for using this tool in combination with serial interface of Router series IE-SR-

2TX-WL(-4G-xx):

Models of Router series IE-SR-2TX-WL(-4G-xx) are equipped with a serial port (Sub-

D9) and support also a Virtual ComPort connection to a Windows PC. For installation of 

the virtual COM port (driver) on the PC this utility can be used also. Configuring a 

Serial-to-Ethernet connection between a serial device connected to the Routers serial 

port and the PC via Ethernet is same as described here for ComServer IE-CS-MBGW-

2TX-1COM running service mode “Virtual ComPort”.
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Run installation file Weidmueller-CS-MBGW-Utility_Vx.x.exe with 

administration rights and follow the installations hints.

6.2 Installation 

Notes about appearance behavior:

If the window of the running program will be minimized (_) or closed (x), 

or if the window of the utility becomes a background window (due to 

focus on other program), then it will disappear into the Windows System 

tray. Open the window again by clicking button ‘Open’ of the Windows 

system tray icon.

For program exit use Menu item File → Exit or click button ‘Exit’ of the 

Windows system tray icon.

After successful completion of the installation the utility can be launched 

in Windows Start Menu.

Note: The utility cannot be seen in section ‘Apps & Features’ respective 

‘Programs and Features’. For removing the program use button 

‘Uninstall’ in Windows Start Menu.

Windows system tray icon

Final display after 

successful installation
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Device table containing detected or configured devices of type 

IE-CS-MBGW-2TX-1COM (ComServer /Modbus-Gateway)

Description of Menus and Buttons

[1a] Button Broadcast Search

[1b] Menu item Device Detection → Broadcast Search

Can be used to detect devices of type IE-CS-MBGW-

2TX-1COM via an Ethernet-based (Layer 2) broadcast. 

Devices can be detected across a switches network 

independent of their IP address settings.

[2a] Button Add Device

[2b] Menu item Device Detection → Add Device by IP

Can be used to add devices of type IE-CS-MBGW-2TX-

1COM via device IP address.

[3] Menu item File → New CS-MBGW-Utility 

configuration

Resets all settings to an initial state. All listed devices 

and all configured virtual COM ports will be removed.

[4] Menu item File → Load CS-MBGW-Utility 

configuration

Loads a previously saved configuration.

[5] Menu item File → Save CS-MBGW-Utility 

configuration

Creates a backup file of current configuration.

[6] Menu item Options → Network Bandwith

Sets an indication about connection speed between the 

PC and connected ComServer(s) for internal timing 

settings.

[7] Menu item Options → Connect Type

Select if internal communication protocol between this 

tool and listed devices will be exchanged readable or 

encrypted (by default).

1a

1b

2b

2a

3

4

5

6

7

6.3 Initial start page (Program Use)
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Step 1: Start a broadcast search via button ‘Broadcast’ for ComServer detection. Select a found 

device and click “Add to Device List”. Alternatively use button “Add Device” to insert a 

ComServer directly via a known IP address.

Step 2: Added device now appears in the device list.

Step 3: Click on menu item <IP address> item to initiate the communication with the selected device. 

To grant access enter same password as used for Web interface access.

Step 4: After successful connection some basic identification data and device settings will displayed.

Currently active

service mode

6.4 How to configure a Virtual COM Port and assign to a ComServer

Retrived system

identification data
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Step 5: Click on button “port1” retrieves the current device configuration regarding Service Mode and Port settings. This 

window is used for creating a Virtual COM Port which will be assigned to serial port1 of this device. 

Step 6: Click button “Create/Map Virtual COM” to create/add a new COM port.

This line shows the ComServer‘s

currently active Service Mode.

6.4 How to configure a Virtual COM Port and assign to a ComServer (ongoing)

Via section Device Configuration the

ComServer can be set (re-configured) to

service mode „Virtual Com“. This feature is

useful if the ComServer is running a 

different service mode (eg. TCP Server). 

This section allows to re-configure to mode

„Virtual Com“ without using the Web 

interface.

Via this section a Virtual COM Port will be

created on this PC and mapped to this

connected ComServer.

Section Device Connections displays the current

connection status of the ComServer. In this

example the ComServer is waiting for establishing

a single VCOM connection (due to current setting

of parameter Max. Connections = 1).

Step 7: After successful mapping of the virtual COM port the new one can be 

monitored as sub item of menu ‘VCOM Ports (This PC)’.

New virtual COM port (COM2) now is created (active) 

and assigned to ComServer with IP 192.168.50.40.

Note: This section shows the status from the

ComServer‘s perspective to which PC it is

connected. For this reason, parameter ‚Destination 

Host‘ shows the IP address of this PC.

Status information

of running virtual 

COM port.

Result: The PC application should be able to communicate with a serial

device connected to the ComServer by addressing PC‘s virtual 

port COM2.

Important note:

1. A running virtual COM port cannot be seen as assigned COM port in the

Windows Device Manager (Section Ports COM & LPT) but it can be selected

by programs/applications which uses a COM port to communicate with a serial

device. For checking which virtual COM port(s) have been created and 

assigned by this utility you need to open menu item ‚VCOM Ports (This PC)‘.

2. A configured and connected virtual COM port is stored permanently on the PC. 

If not explicitly removed the virtual COM port automatically will go active again

after next PC‘s start or reboot and tries to re-connect to the assigned

ComServer if available. (For removing and release of the virtual COM port

please refer to next page).
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Disconnection:
For disconnecting the virtual COM port from the ComServer one of the ‘Unmap/Disconnect’ buttons can be used 

(see 3 markings in screenshots below). After unmapping the COM port number still is assigned to this utility and 

can be used again for a reconnection to the ComServer.

6.5 How to disconnect from a ComServer and removing a Virtual COM Port

Remove (and Program Exit):
A created virtual COM port can be removed and released when exiting the program. 

Step 1: Select File → Exit (Drop-down menu) or click alternatively entry “Exit” of program icon in the 

Windows system tray.

Step 2: After click on Exit below window appears for selection how to go on with created virtual COM 

port(s). Select either option

- Keep the defined virtual COM ports residential and running or

- Remove defined Virtual COM ports

to remove and release all defined virtual COM ports completely after program exit.
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Please consider that at least Firmware version 3.03 (or higher) has to 

be installed on device IE-CS-MBGW-2TX-1COM to be compatible with 

ComServer / Modbus Gateway Utility. A connection to devices having 

previous version 3.02h or lower will be refused and an error message 

will be displayed.

If necessary, download latest firmware version from the Weidmüller

Online Product Catalogue and upgrade the device. For download select 

or search device name IE-CS-MBGW-2TX-1COM or part number 

2682600000 and refer to section ‘Downloads’.

6.6 Firmware requirement of IE-CS-MBGW-2TX-1COM for use with ComServer / Modbus Gateway Utility

Error message if trying to

connect to a device running

firmware version 3.02h or

lower.



User Manual ComServer / Modbus Gateway IE-CS-MBGW-2TX-1COM

February 02, 2023 / Edition 1.3.1 Page 45

A) Application Examples

Subsequent pages provide some application examples in terms of the configurable device features (Operation Modes).
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Scenario: PC application is communicating with a remote serial device via 

the ComServer (Serial / Ethernet Converter) by addressing a 

(virtual) COM Port.

Ethernet

Device with serial

interface
IP: 192.168.50.40

Installed virtual 

COM port: COM2

Software application

for serial device

(addressing the device

via COM2)

Microsoft Windows PC

Configuration settings of ComServer/Modbus-GW Utility for illustrated application:A1) Sample application for service mode “Virtual COM”

IP: 192.168.50.97

Note: For preparing this application all settings can be done using only

ComServer/Modbus-GW Utility, including ComServer configuration

for service mode ‚Virtual COM‘, which will be set by internal 

communication between the software and the connected

ComServer.

An additional device configuration via Web interface only is

necessary if other parameters like Device Description, Timer/Event-

Log settings or special settings regarding data processing

parameters shall be done.

Service mode settings shown by Web interface after setup by ComServer/Modbus-GW Utility:

Serial Line

(RS232, 115200, 

8, 1, None)
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IE-CS-MBGW-2TX-1COM

Service Mode: TCP Server

ComServer is acting as TCP Server. Waits 

passively for host computers to establish a 

TCP/IP connection.

Any payload of a received IP packet will be

sent out to the serial interface and vice 

versa.
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A2) Sample application for service mode ‘TCP Server’

Scenario: Control/Monitoring Device is communicating with remote serial 

device via the ComServer (Serial / Ethernet Converter) by TCP 

protocol. The Control/Monitoring Device establishes actively the

TCP/IP connection to the ComServer.

Ethernet

Device with serial

interface

IP: 192.168.50.40

TCP Client

Opens actively a TCP/IP 

session with 

ComServer. Data 

exchange shall run 

using TCP / Port 4000.
IP: 192.168.50.97

Any Ethernet Control/Monitoring Device

Serial Line

(RS232, 115200, 

8, 1, None)

Serial Port related ComServer settings for illustrated application:

Note:

These parameters for

data flow control are

optional and do not 

need to be changed

for most applications.
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IE-CS-MBGW-2TX-1COM

Service Mode: TCP Client

ComServer is acting as TCP Client.

Establishes actively a connection to defined 

TCP Server (192.168.50.97 / TCP / 4000) to 

forward data received by the serial device.

Any received serial data stream will be sent

out to the Ethernet interface and vice versa.
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A3) Sample application for service mode ‘TCP Client’

Scenario: Control/Monitoring Device is communicating with remote serial device 

via the ComServer (Serial / Ethernet Converter) by TCP protocol. The 

Control/Monitoring Device is configured as TCP Server for data

reception forwarded by ComServer.

Ethernet

Device with serial

interface

IP: 192.168.50.40

Any Ethernet Control/Monitoring Device

IP: 192.168.50.97

TCP Server

Waits passively for

ComServer (TCP Client) for

establishing a connection

(TCP / Port 4000) for data 

exchange received from 

serial device.

Serial Line

(RS232, 115200, 

8, 1, None)

Note:

These parameters for

data flow control are

optional and do not 

need to be changed

for most applications.

Serial Port related ComServer settings for illustrated application:
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A4) Sample application for service mode ‘UDP Server/Client’

Scenario: 2 Control/Monitoring devices shall communicate with a remote serial device via the   

ComServer (Serial / Ethernet Converter) by UDP protocol.

- Control/Monitoring Device 1 is configured as UDP Client pushing data to serial device

via ComServer.

- Control/Monitoring Device 2 is configured as UDP Server for serial data reception

forwarded by ComServer.

Serial Line

(RS232, 115200, 

8, 1, None)

Ethernet

Device with serial

interface

IP: 192.168.50.40

Ethernet Control/Monitoring

Device 1

IP: 192.168.50.97

IE-CS-MBGW-2TX-1COM

Service Mode: UDP Server/Client

ComServer is configured to act for both:

- being UDP Server for Ctrl/Monitoring Device 1 

- being UDP Client for Ctrl/Monitoring Device 2

Ethernet Control/Monitoring

Device 2

IP: 192.168.50.98

UDP Client

Sends actively data to serial 

device via ComServer (UDP 

/ Port 4000).

Note:

These parameters for

data flow control are

optional and do not 

need to be changed

for most applications.

Serial Port related ComServer settings for illustrated application:

UDP Server

Listens (UDP / Port 4001) for

data from ComServer (UDP 

Client) sent from serial 

device.
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RS485 2-wire (19200, 8, 1, None)

Ethernet

Modbus TCP Master Modbus TCP Slaves

Modbus

RTU Slaves

IP:

192.168.50.97

ID

10

ID

11

ID

12

u-remote I/O 1

IP: 192.168.50.198

ID 1

u-remote I/O 2

IP: 192.168.50.199

ID 2

u-remote I/O 3

IP: 192.168.50.200

ID 3

Sensor 1

ID 10

F-Code 3:

Register values:

Reg. 0: 100 / Hex 0064

Reg. 1: 101 / Hex 0065

Reg. 2: 102 / Hex 0066

Sensor 2

ID 11

F-Code 3:

Register values:

Reg. 0: 200 / Hex 00C8

Reg. 1: 201 / Hex 00C9

Reg. 2: 202 / Hex 00CA

Sensor 3

ID 12

F-Code 3:

Register values:

Reg. 0: 300 / Hex 012C

Reg. 1: 301 / Hex 012D

Reg. 2: 302 / Hex 012E

A5) Sample application for service mode ‘Modbus TCP Master to 

Serial Slave Gateway’

Scenario: 3 Modbus RTU slaves (Sensors) shall be integrated into a Modbus TCP 

application with Modbus TCP Master.

IE-CS-MBGW-2TX-1COM → Service Mode: Modbus TCP Master to Serial Slave Gateway

Device is acting as Modbus TCP/RTU protocol gateway.

• Accepts a Modbus TCP request and forwards as RTU request to the addressed RTU slave.

• Forwards received RTU response as TCP response to the requesting Modbus TCP Master.

IP: 192.168.50.40

Serial Port related Modbus Gateway settings for illustrated application:

Monitored data traffic passing the Modbus Gateway:

Monitored request / 

response process

cycles of:

Incoming Modbus TCP Request 

Forwarded RTU Request

Received RTU Response

Forwarded TCP Response

Sensor 2 (ID 11)

Sensor 3 (ID 12)

Sensor 1 (ID 10)
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RS485 2-wire (19200, 8, 1, None)

A6) Sample application for service mode ‘Modbus Serial Master 

to TCP Slave Gateway’

Scenario: 3 Modbus TCP slaves (Remote IOs) shall be integrated into a serial Modbus 

application with Modbus RTU Master.

IE-CS-MBGW-2TX-1COM → Service Mode: Modbus Serial Master to TCP Slave Gateway

Device is acting as Modbus TCP/RTU protocol gateway.
• Accepts a Modbus RTU request and forwards as TCP request to the TCP slave according to defined ‘Modbus 

TCP slave List’.

• Forwards the received TCP response as RTU response to the requesting Modbus RTU Master.

o The ‘Virtual ID’ is used to address several TCP clients - having the same real Device (Unit) ID - by a unique 

ID. If configured for a slave entry in the “Modbus TP Slave List” a Modbus Master has to address this 

‘Virtual ID’. The Modbus Gateway replaces it with the real Device ID and forwards the request to the TCP 

slave. When receiving the response from TCP slave containing the real Device ID, it will be replaced by 

Virtual ID and sent back to requesting RTU/ASCII Master.

o If not configured, the COM-Server handles the communication between RTU/ASCII Master and TCP Slave 

via its real Device ID.

Serial Port related Modbus Gateway settings for illustrated application:

Ethernet

Modbus RTU Master

Modbus TCP Slaves

Modbus RTU Slaves

IP: 192.168.

50.40

ID

10

ID

11

ID

12

Sensor 1 Sensor 2 Sensor 3

Monitored data traffic passing the Modbus Gateway:

u-remote IO 1

IP: 192.168.50.198

ID 1 (real Device ID)

F-Code 3:

Register value:

Reg. 0: 08 / Hex 08

Adressed from RTU 

Master by

virtual ID 13

u-remote IO 2

IP: 192.168.50.199

ID 1 (real Device ID)

F-Code 3:

Register value:

Reg. 0: 06 / Hex 06

Adressed from RTU 

Master by

virtual ID 14

u-remote IO 3

IP: 192.168.50.200

ID 1 (real Device ID)

F-Code 3:

Register value:

Reg. 0: 10 / Hex 0A

Adressed from RTU 

Master by

virtual ID 15

Monitored request / 

response process

cycles of:

Incoming Modbus RTU Request 

Forwarded TCP Request

Received TCP Response

Forwarded RTU Response

u-remote 1

(V-ID 13)

u-remote 2

(V-ID 14)

u-remote 3

(V-ID 15)

Example of error message for

wrong ID adressing (ID=1)

Defined Modbus 

TCP slaves


